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Download and install 

Download the BricsCAD Free Trial 

The download form is simple, without requiring you to provide a lot of excess information. 

Just enter your email address and then select the options for your download! You can select 

from Windows, Mac or Linux operating systems in 18 different languages! If you select the 

Windows operating system, you can also choose whether you want the 32 or 64-bit version. 

After specifying your download options, agree to the Terms of Use and choose Download. 

 

 

 

 

 

 

 

 

If you haven’t yet created a Bricsys account using the email address you entered, you can 

create one or enter a different email address for which you’ve previously created a Bricsys 

account. Then you’re ready to download! 
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You may have the option to Run the install as soon as it downloads or save the download to 

install later. Based on experience with other CAD software, you may automatically want to 

save the download first and then install it another time. Why do you do that? The download 

and install of some popular CAD applications takes a significant amount of time. So, you 

separate them into two tasks that you can squeeze into your busy workday. No need to 

squeeze with BricsCAD! It’s fast! You won’t even have time to grab a coffee during the few 

minutes it takes to download and install BricsCAD! You’ll just have to find another excuse for 

your coffee break. 

In fact, BricsCAD downloads and installs so fast that many newbees, like me, try to 

download it multiple times thinking it’s failed! Rest assured it’s just THAT fast! So, feel free 

to save the download and install later, but don’t let time constraints be the reason why! I 

prefer to get it done, so I choose Run! 

Install BricsCAD Software 

On my system, with a wireless connection, it took about 1 minute to download. When it 

finishes downloading, the installer prompts you to accept the license agreement and install 

location. You can also choose to add a shortcut to the desktop and automatically display 

release notes when the install completes. And for those of you considering a move from 

AutoCAD®, notice the options for file associations. I expect those look familiar to you! 
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If you’re sitting right there ready to respond to those prompts, the install only takes about 

one minute. So, don’t be tempted to take that coffee break just yet! 

 

When BricsCAD finishes installing, you can choose to activate it using the 30 day trial or 

enter a valid license key. 

 

If you choose to activate the trial, each time you launch BricsCAD you’re reminded how many 

days are remaining in your trial and you’re offered another opportunity to enter a valid license 

key. 
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Welcome to BricsCAD 

 

The first thing you’ll notice when you launch BricsCAD, after installing, is the Welcome 

window. Initially the Welcome window has only 3 tabs: Profile Presets, What’s New, and 

Tutorials. A fourth tab, Get Started, is added based on your profile selections. I’ll introduce 

you to these tabs from the bottom up. 

Welcome – Tutorials 

The Tutorials tab is what you would expect from the title and more! It’s a great resource 

whether you’re completely new to BricsCAD or a veteran user trying to advance your skills. 

Scrolling through the Tutorials list you can select from a variety of categories including 2D 

drafting and Programming as well as industry-specific topics for BIM, mechanical and sheet 

metal design. Link to instructional blog posts in addition to more than 100 videos. The 

Tutorials tab also provides easy access to the Bricsys website and other relevant topics and 

news. 
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Welcome – What’s New 

The What’s New tab offers important information about software fixes and improvements. 

 

Welcome – Profile Presets 

If you’re like me, you greatly value Tutorials and Important stuff. But, when launching a new 

CAD application for the first time, you want to jump in and give it a try! This is where the 

Profile Presets tab comes in. The BricsCAD trial includes 4 preset profiles. First select the 

profile (Drafting, Modeling, BIM or Mechanical) and the units (Imperial or Metric) you want to 

use. Then enter a name for the profile or accept the default profile name. Each time you 

select a Profile Preset, it’s added to the Get Started tab. 
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Welcome – Get Started 

The Get Started tab is just that! It’s where you launch into BricsCAD to start your design. 

First, at the bottom of the tab, set your current profile. Then, at the top of the tab, select one 

of the options to create or open a drawing. You can always change the profile, later, within 

BricsCAD. The Get Started tab is simply specifying which profile is used when it launches. 
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Coming from AutoCAD® 

If you’re joining me on this journey as a former AutoCAD® user, you may prefer to skip the 

Welcome window in the future and simply launch BricsCAD like AutoCAD® does by default. 

No Problem. Here’s how! 

1. From the Profile Presets tab, choose Drafting and choose Ok. 

2. From the Get Started tab, set Drafting as the current profile. 

3. Select the option in the lower right corner to turn off the Welcome window. 

4. Select New drawing. 

When you launch BricsCAD in the future, you go straight into the application using the 

default drawing template and with the Drafting workspace active. Later, if you change your 

mind and want to restore the Welcome window, simply set the GETSTARTED system variable 

to On and relaunch BricsCAD. 

Exploring the Interface 

 

During this stop on our BricsCAD journey, we’ll explore the user interface. The appearance of 

the BricsCAD application window varies slightly depending which profile you selected. The 

main user interface elements, however, apply across profiles even if the tools differ. And, if 

you’re coming from AutoCAD®, like me, the interface should look comfortingly familiar. 
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I won’t cover all the user interface elements. Instead I’ll focus on the differences that are 

most noticeable to me as a former AutoCAD® user. 

Menus, toolbars, and the ribbon 

Many CAD users want nothing to do with the ribbon because it can take up significant 

drawing space. They prefer, instead, to access their tools from the command line or from 

menus and toolbars. Others, like myself, are willing to give up screen space in exchange for 

easy access to relevant tools on the ribbon. 

 

Command line 

If you’re a veteran- or power-user, you likely rely heavily on the Command line. In fact, you 

may prefer it over menus, toolbars, and the ribbon. You’ll notice the Command line is docked 

at the bottom of the display. If you prefer, you can drag and dock it at the top or sides. And, 

of course, you can drag it to the drawing area or even another monitor as a floating palette. 

As a former AutoCAD® user, you may notice the Command line doesn’t have clickable 

options. Instead, BricsCAD automatically displays all the Command line options in an 

easy-to-access list displayed in the upper right corner of the drawing area. No need to 

right-click! If you prefer the option list in another location, you can drag it, even to another 

monitor, while you’re in the command. 
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A right-click menu enables you to control the behavior of the Command line. 

 

 

Dockable Panels (a.k.a. Palettes) 

You may not think of the Command line as a dockable panel (palette), but it is. Other 

dockable panels include Properties, Sheet Sets and, of course, Tool Palettes. Dockable 

panels are special because they can be docked or floating and easily resized. And, unlike 

dialog boxes, they can remain open while you’re using other commands. In BricsCAD, 

dockable panels have another special power that may surprise most AutoCAD® users. They 

can be combined to create  tabbed panels! Simply open your favorite dockable panels and 

then drag one panel to the center of another one. When the blue box appears, let it drop. 
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Voila! Multiple panels, stacked on top of each other, consuming minimal space! 
If you’re ambitious, or maybe crazy, you can stack all the dockable panels! 

 

Lookfrom 

The name, LookFrom, might not be familiar to you 

former AutoCAD® users, but the functionality 

probably is. It’s the navigation control in the upper 

right corner of the drawing window that lets you 

look at your model from different sides. Pass your 

cursor over the LookFrom tool and select the side 

from which you want to view your model. A 

right-click menu offers relevant controls. 
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Layouts 

I promised to point out the “most noticeable” differences as I travel through the land of 

BricsCAD. In general, drawing layouts look and act as you may expect coming from 

AutoCAD®. I did, however, notice this little icon next to the Model tab. While this is barely 

noticeable, it’s certainly worth a mention! 

 

 

Selecting that icon opens the Layout Manager where you can view, add, copy, remove, and 

reorder layouts in a single location! Easily select and manage multiple layouts. And, you can 

even search for character strings to easily find relevant layouts. A handy tool for working on 

drawings with many layouts! 
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Command Access 

Using the Command line 

The Command line is, historically, the fastest and most efficient method for most users to 

launch commands and set system variables. Command names, aliases, and system 

variables are, in most cases, the same in BricsCAD and AutoCAD®. If, as a former 

AutoCAD® or AutoCAD LT® user, you primarily use the Command line to launch commands, 

your transition to BricsCAD will be virtually seamless. So, jump in and get started! 

If you enter a command or system variable that isn’t found, check out this document. It has 

valuable information for AutoCAD® users transitioning to BricsCAD. At the end of the doc, 

you’ll find appendices for mapping commands and system variables. 

Like AutoCAD®, BricsCAD has more than 1700 commands and variables. That’s a lot to try 

and remember if you’re relatively new to either of these applications. So, although Command 

line access is fast and readily available, I’ll focus on the UI as I document my BricsCAD 

Journey. I won’t, however, address every UI access method. Instead, I’ll focus on what’s 

significantly different from AutoCAD®. 

Using menus, toolbars and the ribbon 

The appearance and location of tools on the toolbars and ribbon varies slightly between 

AutoCAD® and BricsCAD. But, not enough to warrant detailed blog posts. If you’re 

accustomed to working in a default AutoCAD® or AutoCAD LT® environment, I’m confident 

you can quickly find your favorite tools and easily adapt to the slight differences in BricsCAD. 

If you’re used to working in a custom environment, you’ll be happy to know the BricsCAD UI 

is fully customizable. I’ll talk more about that in a future post. But not until you’ve had a 

chance to experience the Quad! 

Using the Quad 

Before you get too attached to traditional user interface elements, I encourage you to step 

outside the box…. And into the Quad! The Quad is a cursor menu. Wait! Before you ask me 

how to turn it off, please continue reading! 
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What’s the Quad? 

At first glance, you may think the Quad is simply a rollover tooltip because it displays basic 

entity properties like color and layer. But the Quad is so much more! It’s intelligent and 

contextual, offering relevant tools and information when you need them right at the cursor! 

The first time I watched someone use the Quad, it blew my mind. He was editing so fast I 

couldn’t see him selecting objects or launching commands. It seemed like the software was 

reading his mind! Like magic! 

Editing with the Quad 

The Quad offers different information and editing tools based on your behavior. If, for 

example, you access the Quad, by hovering over or selecting an entity, it displays basic 

information about the entity, which you can edit. It also includes the most recently used 

*relevant* tool for editing that type of entity. You can select the tool, which is right by the 

cursor. Or, simply right-click on the entity to launch the command. You don’t even have to 

select the entity or the tool! 

 

If the current tool isn’t what you want, hover the cursor over the tool to expand the Quad. 

Additional recently used *relevant* tools are displayed. 

 

If the tool you want still isn’t accessible, pass your cursor over any of the tabs at the bottom 

of the Quad to expand the command groups and select a *relevant* tool. 
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Did you notice my repeated emphasis on *relevant*? BricsCAD software includes hundreds 

of commands but only the ones most relevant to your current context are displayed in the 

Quad. The relevant tools for editing a polyline, for example, are quite different from those for 

editing text. So, the type of entity you’re editing determines which tools are displayed in the 

Quad. 

 

Drawing with the Quad 

The Quad isn’t limited to editing existing entities. You can, for example, draw and insert new 

entities using the Quad. Simply right-click in a blank part of the drawing area with no entities 

selected. The Quad offers easy access to draw and insert tools as well as general ones such 

as Print and Settings. 
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Why the Quad? 

The speed with which you can access commands using the Quad is a clear benefit. The 

Quad offers a robust set of drawing and editing tools right at the cursor, with minimal clicks. 

With all the necessary tools appearing as you need them, is there any reason to access 

toolbars? Menus? The ribbon? What about the command line? 

Curiosity got the best of me. So, I turned off the menu and Command line and turned on 

CLEANSCREEN. Starting with a blank drawing, I drew my office. I created layers, drew a 

rectangle and arc. I exploded, offset, copied, mirrored, moved, trimmed, extended, 

dimensioned, and modified dimension properties. And, I did it all with the Quad! I only used 

the keyboard to enter values and deselect entities (ESC key). 

Nearly everything I know about the Quad, I learned while writing this blog post. I could have 

drawn my office plan using the familiar Command line and keystrokes I’ve used for more 

than 30 years. But, even as a brand-new BricsCAD user, I did it faster with the Quad! I wish 

you could have watched me as I was drawing my floorplan. My dogs were here to observe 

but they just didn’t share my enthusiasm. The Quad is so Qool!! 
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Let’s make a deal 

At the beginning of this section, I encouraged you to keep reading before asking me how to 

turn off the Quad. Thanks for indulging me! Now, how ‘bout we make a deal? I’ll tell you how 

to turn off the Quad if you promise to commit one lunch hour to drawing your office plan 

using nothing but the Quad? I’ll even share a few bonus tips that I learned while working with 

the Quad. 

Tip 1: Contextual menus, similar to AutoCAD®, are available if you select an object and then 

right-click and hold for a second before releasing. If you release too quick, it displays the 

Quad. I’m only sharing this to help you with your transition. I doubt you’ll need the right-click 

menu after you’re comfortable with the Quad. 

 

Tip 2: When running with CLEANSCREEN on and the Command window off, look in the lower 

left corner of the drawing area. A prompt, command history and even suggestion list if you 

type a command, are subtly displayed without taking any screen space! 
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Tip 3: You can turn the Quad on or off using the status bar control. Right-click on it for 

additional controls. But, remember our deal! 
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Exploring Trial Levels 

To understand what’s included in the BricsCAD trial, it’s helpful to first understand the 

BricsCAD purchase options. 

BricsCAD Editions 

You can purchase BricsCAD available in three different editions: Classic, Pro, and Platinum. 

The BricsCAD Classic edition is for 2D drafting and is comparable to AutoCAD LT®®. 

However, it also includes full LISP support! The Pro edition adds 3D modeling, visualization 

tools, and access to third-party applications. It’s comparable to AutoCAD®. BricsCAD 

Platinum adds 3D constraint creation, design intent recognition, assembly modeling, 

deformable modeling and 3D Compare.  I don’t know what to compare that to! I guess that 

makes it incomparable! 

 

Visit https://www.bricsys.com/bricscad/ to learn more about the BricsCAD purchase 

options. 
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BricsCAD Modules 

While BricsCAD Pro and Platinum offer significant CAD functionality to typical designers, you 

may want more. Therefore, Bricsys offers three optional modules that are built on top of 

BricsCAD: BIM, Mechanical, and Communicator. You can add any or all of these modules to 

BricsCAD Platinum. The BIM module enables you to create full-featured building information 

models. The Mechanical module enables product design and manufacturing for assembly 

modelling. It also enables you to import, create, unfold, rework and export sheet metal parts. 

The Communicator module allows you to import and export 3D CAD data from popular 

manufacturing file formats including CATIA, Inventor, and SolidWorks. Unlike BIM and 

Mechanical, the Communicator module is not installed with the Trial download of BricsCAD. 

However, you can download and install a trial version of Communicator with either the 

BricsCAD Pro or Platinum editions. 

Trial Levels 

When you install BricsCAD, it automatically installs the Platinum edition. If you access it 

using a trial license, you can also try the BIM and Mechanical modules. You may wish to test 

the differences between editions and modules to determine which combination is right for 

you. Let me introduce you to the RUNASLEVEL command! 

While in trial mode you can use the RUNASLEVEL command to change the behavior of 

BricsCAD. First, choose the BricsCAD option and then enter which edition you want to try: 

Classic (C), Pro (P) or Platinum (PL). You’ll have to close and restart BricsCAD to see the 

changes. 

 

Changing the BricsCAD level allows you to experience each of the editions during your trial 

period! Similarly, use the RUNASLEVEL command to enable or disable BIM and Mechanical 

tools. You can try as much, or as little, BricsCAD functionality as you want without having to 

install or uninstall additional software! 
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Exploring each Workspace 

 

Thanks for joining me on my journey as I explore each pre-defined workspace in BricsCAD.  

In my Welcome to BricsCAD topic, I introduced you to Profile Presets. The profile you select 

determines which workspace is active when you launch BricsCAD. Regardless of which 

profile you select, you can easily change the current workspace. Simply right-click on the 

Workspace control in the status bar. Now, let’s take a closer look at each of the pre-defined 

workspaces. 

 

Drafting Workspaces 

In the Drafting and Drafting (toolbars) workspaces, you have easy access to the most 

common tools for drafting and annotation. These tools are available in all the BricsCAD 

editions from Classic to Platinum. If you’re exploring BricsCAD as a former AutoCAD LT® 

user, the Drafting environment should feel familiar to you. However, the Drafting and Drafting 

(toolbars) workspaces in BricsCAD include valuable tools you won’t find in AutoCAD LT®. I’ll 

describe some of them in future posts. 
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Modeling 

The Modeling workspace offers easy access to tools for 3D modeling and visualization. 

These 3D tools are available in the Pro and Platinum editions. If you try to access them while 

your Trial level is set to Classic, you’ll see most of the 3D tools are disabled. 

 

Mechanical 

The Mechanical workspace is optimized for mechanical and sheet metal design. For 

mechanical design start by creating or importing a 3D solid. Then, easily modify your design 

using 3D direct modeling tools and constraints. Next, combine your parts with standard 

parts from the included libraries to create complex assemblies. The mechanical tools and 

libraries in the mechanical workspace are available in the BricsCAD Platinum edition. 
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For sheet metal design, create or import the desired shape of the solid using direct modeling 

operations. Then, convert them to sheet metal to prepare for production. Next, automatically 

unfold sheet metal parts with a single click. Rework your designs at any time without having 

to restart from scratch. Finally, export your design for CNC machining. 

 

BIM 

The BIM (Building Information Modeling) workspace includes tools and libraries to design 

your building from concept through documentation. First, use direct modeling functionality 
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to imagine and explore your designs. Then, attach information such as materials and 

compositions to building elements. Finally, generate sheet sets with design documents 

directly from your building model. The BIM tools require BricsCAD Platinum edition with a 

BIM license (included in the 30-day trial). 
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Drawing Entities 

 

During this stop on our journey through BricsCAD, we’ll focus on the most fundamental 2D 

drawing entities. These are available in every edition of BricsCAD from Classic through 

Platinum. As we continue our journey through BricsCAD, we’ll explore one level (edition) at a 

time. We’ll start with BricsCAD Classic, which is most comparable to AutoCAD LT®. To 

ensure we don’t accidentally detour, set RUNASLEVEL for BricsCAD to Classic. And, since 

the Classic edition is focused on 2D drafting, set your workspace to Drafting. With these 

settings, the tools you need for typical 2D drafting and annotation operations are readily 

available. 

Most of the commands we review in this topic are available from the Quad. They’re all 

accessible using other methods including the menu, toolbars, ribbon, and the Command line. 

In a future topic I’ll show you how to customize the Quad with whatever tools you want. 

 

Tip: In addition to selecting command options by entering them on the Command line, you 

can select them from the option menu in the upper right corner of the display. The menu also 

includes a Cancel option, offering an alternative to pressing the Esc key. 
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Draw Polylines, Splines, Ellipses, Elliptical Arcs, and Wipeouts 

The processes to create Splines, Polylines, Ellipses, Elliptical Arcs, and Wipeouts in BricsCAD 

are just as you would expect in AutoCAD®. 

Draw Lines 

The Line tool in BricsCAD works, by default, like you would expect. It includes the ability to 

enter the length and angle via dynamic input. However, BricsCAD also includes Command 

options to switch between Angle and Length. This offers you additional design flexibility 

even when Dynamic Input is turned off. Another minor difference is the terminology to 

continue a new line, arc or polyline from the last segment. In BricsCAD, the option is “Follow” 

instead of Continue. 

 

Draw Rectangles 

The default behavior to draw a rectangle should be familiar to you. However, BricsCAD 

includes additional options offering maximum flexibility with minimal clicks. Creating a 

square is a great example! 
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Draw Arcs 

The methods to draw an Arc, by default, are as you would expect. However, BricsCAD 

includes all the arc creation options after the first pick. It provides more flexibility with fewer 

clicks. For example, you can pick the first point of an arc. Then, use the Direction option to 

specify its direction of tangency. 

 

Draw Circles 

The options to draw a circle in BricsCAD should be familiar to you. However, the Circle 

command includes two extra options that you may not expect, but will certainly appreciate! 

One option allows you to quickly convert an arc to a circle. 
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The other option, Multiple, enables you draw a circle and then copy it as many times as you 

like. The center of each new circle is placed in relation to the previous one. This allows you 

to create many circles, quickly and accurately. Very handy! 

 

Draw Polygons 

The default behavior to draw a polygon in BricsCAD works as you expect. However, it also 

includes an option for you to specify a line width while you draw the polygon. This reduces 

the need for you to modify the width property after it’s created! When you create a polygon 

using the center option, you might notice a difference in terminology. Instead of prompting 

for inscribed or circumscribed, it asks if you want to select using the midpoint of the side or 

the vertex. Intuitive terminology! 
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Draw Hatches 

The Hatch creation tool in BricsCAD is very much like using AutoCAD® without the ribbon. It 

displays a familiar Hatch and Gradient dialog box with the controls you need to create a new 

hatch or gradient object. 
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Draw Boundaries 

The method to create a boundary in BricsCAD is very similar to AutoCAD®. It displays a 

familiar Boundary dialog box with the controls to create a polygonal boundary. 

 

Draw Centerlines and Center marks 

The process to add centerlines and center marks is as you expect. However, BricsCAD 

automatically applies a center linetype to centerlines. 

Note: The CL and CM command aliases don’t launch CENTERLINE and CENTERMARK in 

BricsCAD. In a future post I’ll show you how to easily change command aliases. 
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Draw Points 

The default process to draw points in BricsCAD is simple and familiar. However, the POINT 

command in BricsCAD offers a Multiple option. This allows you to insert multiple points 

without having to relaunch the command each time. 

Draw Donuts 

You have never seen a donut like this before! By default, it behaves as you expect. But, unlike 

the donuts of your past, BricsCAD donuts come in many flavors! You’re not required to 

create and place the donut only by its center point. You can choose from familiar circle 

creation options including 2 Point, 3 Point, and Tangent, Tangent, Radius. 

 

When you use any of those options, you are prompted to specify the width and diameter of 

the donut. That’s more intuitive than specifying the inside and outside radius! 
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Draw Solids 

BricsCAD offers three additional options in addition to the default expected behavior for 

drawing solids. You can create rectangular, square, or triangular solids. After you draw one 

of these shapes, you can create more of the same shapes with minimal clicks. 

 

Draw Xlines and Rays 

Xline and Ray work as expected. You might, however, notice the Parallel option for Xlines. It’s 

the same as the Offset option in AutoCAD®. 

Drawing with Sketch 

The Sketch command in BricsCAD works as expected by default. However, the options vary 

considerably. I won’t go into all of them here. 
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Settings for Drawing Entities 

 

During the last stop on our BricsCAD journey, we reviewed tools to create fundamental 

drawing entities. Now we’ll look at some of the settings that control how those entities are 

created. 

The default values and preferences to create many of the fundamental 2D drawing entities 

are specified by system variables. You can view and modify variables in BricsCAD using the 

SETVAR command at the Command line. If you prefer to change variables through the user 

interface, you can use the Settings dialog. It offers a single, central location to view and 

modify all the variables in BricsCAD. There are more than 900 of them! 

BricsCAD Settings 

Access Settings from the General menu on the Quad or via other methods including the 

Command line (SETTINGS, OPTIONS). 

 

With so many variables, I can’t possibly cover them all in this post. Instead, I’ll focus on the 

ones for entity creation. After opening the Settings dialog box, expand the Drafting node and 

then expand Entity Creation. These properties apply to new entities you create. At the top of 

the list are general properties including color, linetype, and layer. Below that are 

entity-specific properties. 
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Expand an entity node, such as Hatches, to view and modify its relevant properties. Select a 

property to display the name of the variable it controls in the lower left corner of the dialog 

box. 

 

Some of the entity controls are available from other locations, such as the Entity Properties 

toolbar. But, you will find ALL of them in the Settings dialog box. You don’t have to navigate 

through multiple dialog boxes in search of the control you want. And, the best part is the 

38 

 



search capability. Enter a relevant term in the search box, such as HATCH or PICK. Relevant 

properties highlight as you click your way through each occurrence of the term. Even if you 

are completely new to BricsCAD, you can easily find the settings you’re looking for! 

 

 

Drawing with Styles! 

 

Now, we explore drawing entities that depend on styles including: Multilines, Text, Mtext, 

Dimensions, Multileader, and Tables. The tools to draw most of these entities are available 

on the Quad. You can, of course, access them from other locations including the Command 

line. 
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Draw Multilines 

The default behavior to draw a multiline is just as you expect. In addition to the familiar 

command options, BricsCAD offers a Follow option. Follow enables you to create a new 

multiline that’s adjacent and colinear to the last mline you created. 

 

Draw Single-line Text 

Like AutoCAD®, BricsCAD includes two text tools: Single- and Multi-line. The default process 

to create single line text is just as you would expect. BricsCAD, however, displays all the 

available options on the Command line so you can view and specify options with minimal 

effort. 
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Draw Multiline Text 

You create mtext (multiline text) in BricsCAD much like in AutoCAD®. However, after you 

pick the first corner to place the text box, you have the option to enter specific values for the 

width and height of the text box. 

 

And, instead of displaying the text editing tools on the ribbon, BricsCAD displays a Text 

Formatting toolbar right above the mtext box. It includes familiar text formatting controls 

such as line spacing, columns, and numbering. 

 

Draw Dimensions 

BricsCAD includes the Dimension tool in the Quad. This allows you to draw multiple types of 

dimensions using the command options. You can access the entire set of 

familiar dimensions from other locations including the Command line. And, of 

course, you can add them to the Quad. 
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Draw Multileaders 

You draw a multileader in BricsCAD very much like you draw one in AutoCAD®. First you 

place the leader lines. And then you enter the text. However, after you pick points to place 

the leader, BricsCAD displays the Text Formatting tools near the leader rather than on the 

ribbon. The Text Formatting toolbar includes all the tools you need to format multiline text as 

part of your leader. 

 

Draw Tables 

The process to create a table in BricsCAD is similar to AutoCAD LT®. The Insert Table dialog 

box offers the most popular table creation options. It includes the ability to import data from 

CSV, XML and XLS files. 
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Defining Styles in the Drawing Explorer 

All the drawing tools I covered in this post are dependent on style definitions. They work as 

you expect from your AutoCAD® experience. However, the way you define styles is different. 

At first glance it may seem overwhelmingly different. But, if you take just a few minutes to 

explore the style definitions in BricsCAD I think you’ll appreciate the differences! 

In BricsCAD all style definitions are managed from a central location, the Drawing Explorer. 

You can access the Drawing Explorer from the General menu on the Quad. It’s also 

accessible via other methods including the Command line (EXPLORER). 

 

If you use familiar methods such as the MLSYTLE, STYLE, DDIM, MLEADERSTYLE, and 

TABLESTYLE commands, BricsCAD automatically expands the relevant style information in 

the Drawing Explorer. In the image below, Text Styles is expanded. Select any of the other 

styles to view and modify those definitions. 

 

This was just a quick introduction to the Drawing Explorer to get you started. We’ll examine 

the Drawing Explorer more topics.   
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License Options 

Choose your Edition 

BricsCAD is available in 3 editions: Classic, Pro, and Platinum. You can see how these 

editions compare to each other and AutoCAD® in the online comparison table. 

If you create general 2D designs, the Classic edition may be right for you. Think of it like 

you’d think of AutoCAD LT®. If you do any 3D modeling or run third-party CAD applications, 

you’ll need BricsCAD Pro. 

BricsCAD Platinum includes assembly modelling with a full 3D constraint system. If your 

designs include mechanical modelling or sheet metal, you can add the Mechanical module 

to BricsCAD Platinum. It offers the best sheet metal modeling solution available today. If you 

work in the building industry and are contemplating a move to BIM, you’ll also need Platinum 

– it is the foundation for BricsCAD BIM. 

 

Choose your Modules 

Three modules are available as add-on applications to BricsCAD: Communicator, 

Mechanical, and BIM. If you design for the manufacturing industry and need to exchange 

data with other popular manufacturing applications, you should consider adding 
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Communicator to your Pro or Platinum edition. Communicator running with BricsCAD Pro 

can import parts. And, Communicator running with Platinum can import full assemblies with 

embedded PMI (Product and Manufacturing Information). 

As I stated above, you’ll need BricsCAD Platinum for mechanical modeling (including sheet 

metal design) or the BricsCAD BIM solution. 

 

Choose your License 

BricsCAD offers flexible licensing options so you can purchase the right software with terms 

that best meet your needs. You can buy a perpetual license or an annual subscription. 

Additional options include volume, network, and academic licensing. 
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Perpetual license 

When you purchase a perpetual license, you own the software! And remember, BricsCAD 

editions run on Microsoft Windows, macOS and Linux – your choice! Pretty amazing, right? 

You can choose from two options. The All-In Maintenance option includes automatic 

upgrades and support. It’s the least expensive way to stay up to date with BricsCAD. Or, if 

you prefer to purchase upgrades at your discretion, you have that option! 

Subscription license 

When you choose the subscription option, you have access to the latest version of BricsCAD 

for a year. It includes Priority Support and access to all new versions that are released during 

the time your subscription is active. 

Academic License 

Students, faculty, instructors, and educational institutions have free access to all BricsCAD 

software for 12 months. And, you can renew it yearly with a current student ID. Simply 

register as a student or school/teacher with your academic information. 

 

Additional license options 

The most common type of license is for a single-user. However, BricsCAD is also available 

with network or volume licenses. 

46 

 

https://www.bricsys.com/en-intl/academic/
https://www.bricsys.com/en-intl/academic/


 

Single user License 

The single user license agreement is for a single user. However, each single user license 

allows two activations. You can install it on two machines, for example a workstation in the 

office and a laptop in the field. But, only one can be in use at any time.  Single user licensing 

is available for perpetual or subscription licensing. Academic licenses for students are 

always single-user. 

 

Network License 

The network licensing agreement enables multiple users to access BricsCAD within a LAN 

(Local Area Network). The number of available network licenses defines the number of users 

who can concurrently use the software. The network license option is available with 

perpetual or rental licensing and includes a one year maintenance contract to get you 

started. Network licensing is also available to institutions using an academic license. 

 

Volume License 

The volume licensing agreement allows you to use BricsCAD software within a defined user 

base. You can install the software using a single license key valid for every user. This greatly 

simplifies license management. The volume license option is available with perpetual or 

rental licensing and includes a one year maintenance contract to get you started. And, it’s 

the default for an institutional academic license. 
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Activate your Trial 

Regardless of which licensing option you choose, you’ll receive a license key to activate your 

trial. First, launch the software and then choose Enter License. 

 

Enter your BricsCAD license key. If you’re using a network license, you may have to contact 

your administrator for relevant server information. 

 

After activating your license, you’ll receive the following message with important 

information. 
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Manage your Licenses 

Inside BricsCAD you can view and manage your software licenses in the License Manager 

(LICENSEMANAGER command). It indicates your active license and enables you to upgrade 

to a higher license. If you purchased a higher license than what is indicated, check the 

RUNASLEVEL setting that I described for trial licenses. If, for example, you purchased a 

Platinum license but RUNASLEVEL is set to Classic, the License Manager will indicate that 

you have a Classic license. And, because the BIM, Mechanical, and Communicator modules 

require at least Pro (Communicator) or Platinum (BIM & Mechanical) editions, those 

modules are inaccessible. 

 

After activating a Platinum license and ensuring RUNASLEVEL is set to Platinum, all three 

modules are accessible. And, if you have remaining trial time for those modules, you can 

continue to use them until they expire. Choose Buy to purchase a license for any of the 

modules directly from the Bricsys store. 
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After you obtain a license key, choose Details. Then, choose Modify and enter the key to 

activate the module. You must relaunch BricsCAD for the new application to load. 

 

Even with BricsCAD and all the modules activated, you can continue to use RUNASLEVEL to 

try the software at lower levels. If you’re a CAD Manager, this can help you determine which 

editions and modules are best suited for various users. For example, you can set the 

BricsCAD level to Platinum and change BIM to No license. Or, set BricsCAD to the Pro edition 

and Communicator to a Full license. 
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Working with Blocks 

 

This BricsCAD adventure is all about blocks!  We’ll review familiar methods to define and 

insert blocks. And, we’ll uncover new tools to manage them. 

Define Blocks 

The process to define a block using the BLOCK command is the same in BricsCAD as in 

AutoCAD®. It displays the Block Definition dialog box with the necessary controls to create a 

new block definition in the current drawing. 

 

Note: The Block Definition dialog box in BricsCAD doesn’t have options for Hyperlink, Quick 

select or Block Editor. You can, however, attach hyperlinks, select objects, and edit blocks 

using alternate methods. 

The familiar WBLOCK command allows you to write out a block definition as a separate 

drawing file, external to the current drawing. 
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BricsCAD doesn’t have a Block Editor. Instead, you create and edit block geometry using the 

drawing editor with all the tools and functionality it has to offer available. 

Insert Blocks 

You can select a block to insert in your drawing from the Insert Block dialog box. It’s easily 

accessible from the Insert tab on the Quad. You can also access it via other methods 

including the INSERT command. 

 

The Insert Block dialog box will look familiar to you as a former AutoCAD® user. It includes 

typical options to specify the insertion point, scale and rotation angle for the block. 
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Note: The Insert Block dialog box doesn’t include an option to insert a block using 

geographic data. 

The Insert Block dialog box doesn’t include a preview image. Instead, BrisCAD offers a more 

intuitive way to preview, insert, and manage your blocks! 

Manage Blocks in Drawing Explorer 

I previously mentioned that Drawing Explorer offers a central location to manage all the style 

definitions in your drawing. In fact, Drawing Explorer does much more than that. It 

centralizes all named drawing content, including blocks, in a single dialog box. 

Access Drawing Explorer from the General menu on the Quad. It’s also accessible via other 

methods including the EXPLORER command. If you launch Drawing Explorer with the 

EXPBLOCKS command (XB alias), it automatically displays the panels for Blocks. 

 

Drawing Explorer lists all block definitions in the drawing and includes relevant information 

and controls. You can see how many instances of a block are in the drawing and you can 

modify basic block properties. For example, you can specify whether a block is Annotative or 

Explodable. 
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Another option, unique to BricsCAD, ensures the block always faces the camera. This can be 

particularly useful (and fun) for 3D visualization. For example, I created a block with an 

image of my photo and inserted it in a 3D model. As I orbit around the model, the 

block/image always faces forward. 

 

The right-click menu and toolbar offer additional controls. You can easily create a new block 

definition, delete a block definition and all its insertions, and purge an unused block 

definition. Insert blocks and even add them to the current tool palette. Anything you want to 

do with blocks is easily accessible from the Drawing Explorer! To learn more, visit BricsCAD 

Online Help. 

54 

 

https://help.bricsys.com/
https://help.bricsys.com/


 

Dynamic Blocks 

BricsCAD enables you to modify instances of dynamic blocks. It does not, however, allow 

you to create or edit dynamic block definitions. Instead, you can easily define blocks using 

BricsCAD 2D and 3D parametric constraints. It’s very cool and I can’t wait to show you how 

in future blog posts! 
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Working with References 

Attach Reference Files 

BricsCAD allows you to attach externally referenced drawings, images, and pdf files to the 

current drawing. Easily access the attach tools from the Insert tab on the Quad. You can also 

access them via other methods including the Command line (XATTACH, IMAGEATTACH, 

PDFATTACH). 

 

You attach reference files in BricsCAD the same way you do in AutoCAD®. First select a 

valid file type: DWG, Raster image, or PDF.  Then, specify attach options in the relevant 

Attach dialog box. Supported raster images include: BMP, JPG, JPEG, PCX, PNG, GIF, TGA, 

TIF, TIFF, JP2, J2K, ECW, and SID. 
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Note: The dialog boxes do not include preview images. However, when attaching a PDF file, 

you can select which page to attach from the page list. 

Manage Reference Files in Drawing Explorer 

After you attach an external file to the current drawing, BricsCAD creates a reference link to 

the file. You can view and manage those links like in AutoCAD®. However, instead of using 

an External References palette, you use Drawing Explorer. 

Access Drawing Explorer from the General menu on the Quad. It’s also accessible via other 

methods including the EXPLORER command. 

 

 

Or, you can use the familiar XREF, IMAGE, or PDF commands. Doing so automatically opens 

Drawing Explorer with relevant panels displayed for that reference type. 

External References 

The External References panels include detailed information such as the referenced .dwg file 

name and size. Additionally, it displays the number of insertions for each .dwg reference. 

Nested references are clearly indicated by the greyed-out attachment type. 
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To help you visualize the individual references and relationships between them, you can 

change to icon or tree view. 

The right-click menu and toolbar offer additional controls. You can easily attach new xrefs, 

detach existing ones, or purge those that are unused.  And you can reload, unload, bind, 

insert, and open attached references. Additional items on the right-click menu make it easy 

to switch the saved path between relative, absolute, or just the file name. And, on the toolbar, 

the “Run extended search for missing attachments” tool enables you to easily fix broken 

reference paths either individually or for multiple references simultaneously. 

Images 

The Images panels display detailed information about the images that are linked to the 

drawing. The menu and toolbar offer tools similar to Xrefs but specifically relevant for 

images. 
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When you add images in BricsCAD, you can select and attach multiple images at the same 

time, unlike in AutoCAD®. 

 

PDF Files 

The PDF Underlays panels display detailed information about PDF files that are linked to the 

drawing. The menu and toolbar offer the same tools as for images. 
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Note: BricsCAD doesn’t include the ability to import geometry from PDF files. However, one 

of the many 3rd party BricsCAD developers offers an add-on application that enables you to 

open and convert PDF files directly in BricsCAD. 
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Working with Layers and Linetypes 

Drawing Explorer 

The default method to create and manage layers in BricsCAD is via Drawing Explorer. 

Because, like everything else in Drawing Explorer, layers are named drawing content. You 

can, of course, launch Drawing Explorer from the Quad and other methods including the 

command line. You can also launch it with the LAYER command (LA alias). Doing so 

automatically displays the Layers panels in Drawing Explorer. 

 

One of the primary benefits of managing layers in Drawing Explorer is the ability to preview 

layer geometry as you manage layer properties. It is similar to the LAYWALK tool in 

AutoCAD®. However, unlike AutoCAD®, BricsCAD enables you to view geometry on any 

number of layers and then, with those layers already selected, you can change their 

properties. It’s very cool and eliminates the need for a separate LAYWALK command. 
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The toolbar and right-click menu provide access to additional tools relevant for layer 

management. For example, you can merge layers or open and close the Filters panel. 

 

Drawing Explorer is incredibly useful as a central location for managing all the named 

content in your drawings. However, it is a dialog box and cannot remain open while you use 

other commands. 

Layers Panel 

If you frequently access the Layers panel, you may want to leave it open while you work. No 

problem! Use the LAYERSPANELOPEN command to display only the Layers panel from the 

Drawing Explorer.  Move and resize it as you wish, and even move it to a second monitor. If 

you find old habits hard to break and prefer for the LAYER command and LA alias to open 
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the Layers panel instead of the Drawing Explorer. It’s easy to change and I’ll show you how in 

a future post! 

 

Layer States 

Layer states are named content stored in a drawing. How do you think you access them in 

BricsCAD? If you answered, “Drawing Explorer”, you’re correct! You can, of course, open 

Drawing Explorer via typical methods. Or you can launch it with the LAYERSTATE command 

(LAS alias) to open it with the Layer States panels already displayed. It includes one panel to 

access layer states and another panel to modify properties for the selected state. 

 

Linetypes 

The LINETYPE command (LT alias) in BricsCAD opens the Drawing Explorer with the 

Linetypes panel displayed. This is where you can load new linetypes or delete existing ones. 

It’s like the Linetype Manager in AutoCAD®. However, in BricsCAD you won’t find controls for 
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linetype scaling (LTSCALE and CELTSCALE) in the Drawing Explorer because those aren’t 

named content. 

 

Instead, you can specify Linetype scales in the Settings dialog box or at the Command line 

like any other system variable. 
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Editing Entities 

Like AutoCAD®, BricsCAD offers multiple ways to edit entities. Some of the most common 

methods are with the Properties panel, grips, and the Quad. 

Editing in the Properties Panel 

BricsCAD offers a Properties panel like the Properties palette in AutoCAD®. You can access 

it with the PROPERTIES command (PR alias) as well as other methods such as 

double-clicking on an object. Since it’s a panel, it can remain open while you work. 

The properties displayed in the panel vary depending on the type of object(s) that you’ve 

selected. In general, they match what you would expect from your AutoCAD® experience. 

There are, however, a few notable differences. For example, the Properties panel in BricsCAD 

displays the Handle (read-only) of the selected entity. The entity’s handle can be useful to 

store and recall for programing purposes. 

You’ll find other valuable additions to the Properties panel for different objects. I can’t 

possibly cover all of them, but below is an example of properties for a selected line. In 

BricsCAD you can edit a line by entering the x,y,z values of the start point, end point, or even 

the delta. It also displays the slope as a read-only value. While this is supposed to be a 2D 

drawing, it’s obvious from the slope of the selected line, that this particular entity isn’t flat. 

You could, of course, edit the z-value of its endpoint to match the start point. However, you 

may incorrectly assume its accuracy beyond the second decimal place. Instead, you can 

change the Delta z-value to 0 ensuring the line is truly flat! 
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Editing with Grips 

BricsCAD supports traditional object grips like AutoCAD®. For example, if you select a circle, 

you can use its center and quadrant grips to move or resize it. BricsCAD does not, however, 

support mutli-functional grips. Instead, much of that functionality is available on the Edit tab 

of the Quad. 
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Editing with the Quad 

As I mentioned before, the Quad offers different edit tools based on the type of entity. Circle 

edit tools are quite different, for example, from Dimension edit tools. When you select a 

dimension, you’re offered tools to modify the dimension or dimension text. For example, you 

can flip the dimension arrowhead nearest to where you selected the dimension. In contrast, 

Circle edit tab includes tools like Trim and Hatch. 

 

The default tool changes based on your most recent editing behavior for that type of entity. 

You can hover over the default tool to display additional recently used tools. The recent tools 

can vary depending if you select the entity or simply hovered over it. 

 

Pass the cursor over a tab at the bottom of the Quad to expand it with even more tools. 

You’ll find the most common tools to edit that specific type of entity on the Edit tab. The 

tools may vary depending if you select the entity or simply hover over it. For example, if you 
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select a line, the Edit tab displays the Lengthen, Break, Join, and Match tools. If you hover 

over a line, without selecting it, the Quad adds Trim and Extend to the tool set. 

 

In this example, if you hover over the line and use the Extend tool, BricsCAD automatically 

extends the highlighted entity to the nearest boundary based on where you hovered the 

cursor. It only takes one pick compared to three picks and two enters using traditional 

methods. Of course, traditional methods are still available. 

 

I shared just a few examples of the intelligence and contextuality of the Quad. In addition to 

the powerful default behavior, you can customize the Quad to meet your needs. More info 

about that later on.  
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Entity Manipulation 

 

Let’s focus for a bit on the tools for editing entities. Most of those tools let you change the 

entity itself. For example, you might trim a line or rotate dimension text. The manipulation 

tools, which we’ll explore today, let you modify those entities in the context of the rest of the 

drawing. Typical examples include Move, Copy, and Rotate. 

Traditional Manipulation Tools 

You can access most of the manipulation tools using typical methods such as the command 

line. They’re also available on the Modify tab of the Quad when you select or hover over an 

entity. Unlike Edit tools which can vary significantly for different entities, the Modify tools are 

relatively consistent. For example, they include Erase, Move, Copy and tools to specify draw 

order. Some entities such as dimensions, hatches, and blocks, also include the Explode tool. 

Since you’re probably familiar with all the traditional modify tools from your AutoCAD® 

experience, I’ll focus on the one that’s unique to BricsCAD, the Manipulator! 

 

Manipulator 

The Manipulator is somewhat like the 3D Gizmos in AutoCAD® (not available in AutoCAD 

LT®). In BricsCAD the Manipulator is useful for both 2D and 3D entity manipulation. 

Therefore, it’s available in all BricsCAD editions including Classic. You can access the 

Manipulator from the Quad when objects are selected. It’s also accessible via other methods 

including the MANIPULATE command. 
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With this single Manipulator tool, you can move, rotate, scale, copy and even mirror the 

selected entities. And, you can easily do so while constraining them along a specific axis or 

plane. Right-click on the Manipulator to access additional controls including a toggle to 

switch the Arrowhead behavior between Mirror and Scale. 

 

Reorient the Manipulator 

By default, the Manipulator displays at the center of the selection set. To move it, you can 

select the relocate grip and pick a new base point for the manipulation. As you move it 

across the drawing, it can automatically align with geometry enabling you to manipulate 

along any relevant axis. The default alignment is with the current UCS. Options on the 

right-click menu offer additional controls to reorient and align the Manipulator. 
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Move 

With the Manipulator properly oriented, you can click an axis or plane to move the selected 

entities. Their movement is automatically constrained to the specified axis or plane as you 

pick the second point. 

 

Rotate 

To rotate the entities around the basepoint of the manipulator, select the rotation arc. 
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Mirror 

Select one of the arrowheads to mirror the entities along either axis. Mirror is the default 

behavior for the arrowheads. You can change their behavior to Scale using the right-click 

menu. 

 

Scale 

With the arrowhead behavior set to Scale, you can select either arrow to scale the selected 

entities from the manipulator basepoint. 

 

Copy 

As you perform any of the four operations using the Manipulator (Move, Rotate, Mirror, 

Scale), you can create a copy of the selected entities. Simply press the Ctrl key as you select 

the operation. 
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Selection Methods 

BricsCAD offers many different methods for you to select entities. You can select them 

before you launch an editing/manipulation command. Or, you can launch the command and 

then select entities. If you launch the command first, the options list in the upper right corner 

of the drawing area displays many of the selection options. 

 

Traditional selection options 

The most common selection methods that you use in AutoCAD® are also available in 

BricsCAD. For example, you can pick two points, left to right, to specify a rectangular 

selection window. Or, pick right to left to specify a rectangular crossing window. 
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And, you can enter additional options for other familiar selection methods. For example, you 

can enter P for the previous selection set or CP to select all entities that are inside or cross a 

specified polygonal boundary. In addition to the selection options that you may be familiar 

with from AutoCAD® (in orange), BricsCAD offers others (in blue). You can, for example, 

select all objects outside a specified window or polygon. 

 

And, you can even create inside, outside, or crossing selections using a circular boundary! 

 

Another option, unique to BricsCAD, is the ability to pick a point in an area surrounded by 

closed boundaries. Any closed boundaries around that point are selected. 
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Select by Properties 

Regardless of how you select entities, you can use the Properties panel to limit the selection 

to a specific type of entity. Then, with that subset selected, you can modify their properties. 

 

Like AutoCAD®, you can access a Quick Select tool from the upper right corner of the 

Properties window. However, instead of launching a separate Quick Select dialog box, 

BricsCAD uses a variation of the Properties panel. 

Quick Select 

In addition to accessing Quick-Select from the Properties panel, you can enter QSELECT at 

the command line. BricsCAD opens the Properties panel with the Quick Select tool enabled. 

You can then use the familiar Properties controls to apply filters for the entities you want to 

select. For example, you might specify all hatch entities on a particular layer with a particular 

pattern. 
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Quick Select functionality also supports the following operators to give you maximum 

flexibility and control. For example, you can choose all circles with a radius greater than or 

equal to a specified value. 
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You can apply the filters to the current selection set or select one of the tools below. The 

first tool adds the filtered entities to the selection set. The second one removes them from 

the selection set. And, the third tool adds the filtered entities to a new selection set. 

 

The powerful combination of Quick Select filters enables you to select exactly what you 

need. And, because they’re available in a panel rather than a dialog box, you can keep them 

open and easily accessible while you work! 

Structure Panel 

BricsCAD offers another method for selecting objects which is also very powerful. It’s called 

the Structure panel and you can access it with the STRUCTUREPANEL command. It’s also 

accessible, along with all panels, when you right-click on a toolbar or the ribbon. 

 

The Structure panel displays a tree view of drawing content.  You can configure it to display 

drawing content in different ways. The default configuration for BricsCAD Classic is called 

Default. It displays all the entities in the current space (model space or layout tab) of the 
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current drawing, first by layer name. You can expand any of the layers to display the entity 

types on each layer. Expand the entity types to see the individual entities listed by their 

handles. Numbers next to each category indicate how many entities it includes. In the 

example below, there are 285 entities on the zero “0” layer including 15 arcs and 30 lines. 

 

 

You can click a category at any level of the tree to select all the entities in that category. Or, 

click individual handles to select those entities. If you double-click on a handle, BricsCAD 

selects the object and automatically zooms to it. That’s handy!! 

 

You can change the configuration for the Structure panel if you right-click in the panel and 

choose Configure. I hope to share the process for customizing configurations in a future 
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post. For now, I’ll show you the other Structure configurations that are included when you 

install BricsCAD. 

 

If you open the configuration list, you should see the Bim and Mechanical configurations in 

addition to Default. The Bim configuration displays the entities by type. The Mechanical 

configuration displays them first by type, then by layer, and then color.  You can choose the 

Select option in the configuration menu to select your own configuration. 
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Drawing Explorer 

 

I first described Drawing Explorer in my Drawing with Styles Topic. There we covered 

Multiline Styles, Multileader Styles, Text Styles, Dimension Styles, and Table Styles. In 

Subsequent posts we looked at Blocks, reference files, layers, and linetypes. Those are some 

of the most common types of drawing content that you can manage in Drawing Explorer. 

But, there are many more categories that we haven’t yet investigated. I’ll briefly describe 

each of them. 

 

Named Drawing Content 

Coordinate systems 

The Coordinate Systems panel displays all the named User Coordinate Systems (UCS) in the 

current drawing. If you choose the option to add a new coordinate system, the UCS 
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command is launched enabling you to choose from options such as picking points or 

selecting an entity. 

 

Views 

The Views panel displays all the named views in the drawing. If you choose the option to add 

a new view, you can save the current view or pick a window to define the view. View and edit 

properties for a selected view in the Edit View panel. 

 

Visual Styles 

The Visual Styles panel displays all the visual styles in the drawing. It includes 11 predefined 

visual styles and you can easily add your own. You can view and edit visual style properties 

in the Edit Visual Style panel. While most visual styles are intended for 3D visualization, 

some of them, such as Sketchy, can be useful for 2D design. Therefore, visual styles are fully 

supported in all editions of BricsCAD, including Classic. 
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Lights 

The Lights panel displays all the lights in the drawing. If you choose the option to add a new 

light, it launches the LIGHT command where you can select from Point, Spot, Web, or Distant 

lights. You can view and edit sun properties in the Edit Properties of the Active Viewport Sun 

panel. That panel also provides access to the geographic location dialog box. While you can 

create and modify lights in BricsCAD Classic, it doesn’t support rendering. Therefore, the 

usefulness of lights in BricsCAD Classic is somewhat limited. 

 

Materials 

The Materials panel displays all the materials in the drawing. You can view and edit Material 

properties in the Edit Material panel. Like lights, however, material functionality is limited in 

the BricsCAD Classic edition because it doesn’t support rendering. 
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Render Presets 

The Render Presets panel displays all the Render Presets in the drawing. It includes five 

pre-defined settings and you can easily add your own. While you can create and modify 

render presets in BricsCAD Classic, it doesn’t support rendering. As a result, its usefulness in 

the Classic edition is limited. 

 

Dependencies 

Dependencies in BricsCAD can best be compared to transmittal sets in AutoCAD®. In fact, if 

you launch the ETRANSMIT command, BricsCAD opens Drawing Explorer with the 

Dependencies panel displayed. There you can view all the dependent files including xrefs, 

images, fonts and more. Select which files to include in the transmittal set and then save 

them to a zip file or folder. You can also upload them to Bricsys 24/7 cloud storage. 
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Page Setups 

The Page Setups panel displays all the page setups in the drawing. If you choose the option 

to add a new page setup, it displays the Page Setup dialog box with its familiar controls. You 

can also select and edit any existing page setups. 

 

Section Planes 

The Section Planes panel displays all the section planes in the drawing. If you choose the 

option to add a new section plane, it launches the SECTIONPLANE command where you can 

select a method, such as Orthographic, to define the new section plane. Easily view and 

modify properties of a section plane in the Edit Section Plane Settings panel. 
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View Detail Styles 

The View Detail Styles panel displays all the view detail styles in the drawing. Easily view and 

modify properties of a selected view detail style in the Edit View Detail Style panel. 

 

 

View Section Styles 

The View Section Styles panel displays all the view section styles in the drawing. Easily view 

and modify properties of a selected view section style in the Edit View Section Style panel. 
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Drawing Content 

In addition to being able to select and modify each of the content types in Drawing Explorer, 

you can select the drawing itself. Doing so displays the number of occurrences of each type 

of content in the drawing. If you double-click on one of the items in the Details panel, that 

drawing content is displayed. 
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Menus 

Drawing Explorer includes four menus: Edit, View, Settings and Help.  Many of the options in 

these menus are also available from the tools and right-click menus in the panels. Others are 

only available from these menus. 

Edit 

The tools in the Edit menu can vary depending which type of content you select. These tools 

are also available in the various panels. 

 

View 

The View menu enables you to control which panels display for each type of content. You 

can also specify if you want to display the content details, icons, or tree view. The Regen 

tools allow you to specify, for each type of content, whether you want the drawing area to 

regen each time you make a change to that content or if you want to manually regenerate. 

Hide xref symbols is relevant for content, such as layers or text styles, that may be listed as 

part of an xref. If you choose to hide xref symbols, the reference content does not display in 

the list. Most of the tools in the View menu are available for all the content types. However, a 

few tools are added for specific content. For example, the last two options in the following 

View menu are only available for Layers. 
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Settings 

The Settings menu has only two tools. The first one enables you to restore the layout of the 

selected content type back to the default settings. The reset will not affect other content 

types. The Options tool displays a dialog box that controls how blocks are inserted using 

Drawing Explorer. 

 

Help 

The Help tool opens the Drawing Explorer Help page online. 

88 

 

https://help.bricsys.com/hc/en-us/articles/360006807833-Drawing-Explorer


 

Column Controls 

You can control the display of the columns for any named content by right-clicking on a 

column header or row number. Turn columns on or off individually or choose the option to 

Show all columns. You can drag and drop columns to rearrange them and easily restore 

them to their default positions. 

 

Open Drawings 

Until now, we’ve focused on the named content of a single drawing. However, the Open 

Drawings tab in Drawing Explorer, lists all the open drawings enabling you to access named 

content from any of them. You can easily drag and drop or copy and paste named content 

from one open drawing to another! While drag and drop works for most of the content, it 
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doesn’t work for all. If drag and drop doesn’t work for you, try copy and paste from the Edit or 

right-click menus. 

 

Folders 

The Folders tab, to the right of the Open Drawings tab, enables you to access drawings from 

local folders and even from Bricsys 24/7. 

Local Folders 

Add local folders to Drawing Explorer for easy access to named drawing content even if the 

drawings aren’t open! Simply expand the drawing and select the content. Then copy it from 

that drawing and paste it into an open drawing. Voila! It’s that easy! 
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Bricsys 24/7 

Bricsys 24/7 offers secure and simple document management. You can Access your 

documents from anywhere and on any device. Share them with your global teams for secure 

project collaboration. And, the best part is that you access the drawings you store on Bricsys 

24/7 directly from BricsCAD! 

From the Folders tab in Drawing Explorer, choose the option to Logon to Bricsys 24/7. If you 

don’t yet have an account, choose Sign up to start your free trial. 

 

After you’ve logged into Bricsys 24/7 you can navigate to your projects and drawings directly 

from BricsCAD. Then, you can download the selected drawing and automatically open it in 

BricsCAD.  Or, simply view drawing content in Drawing Explorer. Another option enables you 

to view drawings on Bricsys 24/7.  We’ll explore Bricsys 24/7 more in a future post. 
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Settings 

Access the Settings dialog box 

Unlike AutoCAD®, BricsCAD centralizes all system variables and user preferences in a single 

dialog box called Settings. If you like to type, you can access the Settings dialog box with the 

OPTIONS or DSETTINGS commands. It’s like accessing the Options or Drafting Settings 

dialog boxes in AutoCAD®.  If you prefer graphical access, you’ll find the Settings tool on the 

Quad. 
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Tools in the Settings dialog box enable you to find and edit the 900+ system variables and 

user preferences in BricsCAD. You can even export all them and their values to a CSV file. 

The settings are divided into three primary categories: Drawing, Dimensions, and Program 

options. An additional category, Compare, is also included. 

The tools at the top of the Settings dialog box, allow you to view the settings in different 

ways. Below those tools is the list of settings. And, at the bottom, you’ll find useful 

information about the selected setting. 

 

Categorized View 

The Categorized tool displays a tree view that groups the variables into the four categories. 

You can expand each category to access relevant variables. And, in many cases, you can 

expand additional subcategories. The Drawing, Dimensions, and Program options tools 

display the corresponding categorized view. 
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Drawing 

The settings in the Drawing category control a variety of drawing behaviors. These include 

many of the settings you would find in the AutoCAD® Drafting Settings dialog as well as 

other locations. 

 

Dimensions 

The Dimensions category is, as you would expect, dedicated to dimension settings. 
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Program Options 

The Program options include many of the settings you would find in the AutoCAD® Options 

dialog box. These include File paths and Open/Save controls just to name a few. 
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Compare 

Compare includes just one setting that is specific to drawing comparison functionality. 
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If you’re coming to BricsCAD from AutoCAD®, you may find the Categorized view a bit 

overwhelming at first glance. But, don’t let it intimidate you. While you can access any of the 

settings by expanding the categories as shown above, there are other ways. Fortunately, you 

can find most of the settings without having to learn the category structure. For example, if 

you right-click on the SNAP or GRID controls from the status bar and choose Settings, the 

Settings dialog opens with Snap/Grid settings expanded. And, you can view all the settings 

alphabetically or use the Find tool. 

Alphabetical View 

If you know the name of the setting you want to modify, you may prefer to display the 

settings instances rather than categorically. Doing so lists all the settings alphabetically 

based on their Title. I emphasize Title because in most cases, the title is different from the 

actual variable name. For example, Angle direction controls the ANGDIR system variable. It’s 

comparable to the Clockwise Angle control in the AutoCAD® Drawing Units dialog box. If 

you’re concerned you may not find what you’re looking for, don’t worry! Be happy! Why? 

Because the powerful Find functionality helps you find the settings you need, even when you 

don’t know what you want! 
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Find 

The Find tools include options a search panel, and up/down controls to navigate through the 

occurrences it finds. This makes the Settings dialog incredibly powerful even if you’re new to 

CAD. For example, you may not know the name of the ANGDIR system variable.  And, you 

may not know its title is Angle Direction. But, you probably know one of the key terms such 

as Angle, Direction, or even Clockwise. You can enter any of these terms in the Search field 

to easily find the setting you want. By default, it searches for the term in the variable name, 

title and value. It also looks for any occurrences in the help description or category names. 

You can turn off any of these options in Configuration to limit the search criteria. You can 

also require it to match case. 

98 

 



 

View and edit settings 

After you find the setting you want, select it to view its current value and properties. If the 

setting is editable, you can click in the value box to change it. The value options vary 

depending on the setting. For example, some may require you to enter a number, while 

others may include a check box or drop-down list. 
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Some settings are grey indicating they’re read-only. In addition, a lock icon in the lower left 

corner of the Settings dialog box clearly identifies them as read-only. 

 

The name and type of variable for the selected setting also displays in the lower left corner 

of the dialog box. The setting title and description are to the right of it. And, for some 

settings, a preview image displays in the lower right corner. 
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Other icons in the lower left corner of the Settings dialog box indicate where BricsCAD stores 

the variable. It saves some in the drawing. Others are stored in the registry as system 

variables or user preferences. A few variables are not saved. 

 

Most BricsCAD settings correspond to AutoCAD® variables. There are, however, a few that 

are unique to BricsCAD. They are clearly indicated by an additional icon. 

 

Edit system variables at the Command line 

The Settings dialog box offers a graphical and intuitive method for you to view and edit 

system variables and user preferences. It can be particularly useful if you don’t know the 

exact name of the variable or if you want to change several variables. However, if you prefer 

to view and edit variables via the Command line, you can do that too! Simply enter the 

variable name or launch the SETVAR command. 

Export settings 

Regardless of how you view or edit settings in BricsCAD, you can easily export them to a 

comma delimited (CSV) file. Use the Export tool then enter the file name and location. 
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With the CSV file created, you can open it in a spreadsheet app to easily view all the variable 

properties. This can be especially helpful for troubleshooting behavior differences between 

different systems or drawings. 
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Classic Edition 

Classic 2D Design and Drafting 

The first stage of our journey has focused on core functionality that’s available in every 

edition of BricsCAD including Classic. If you’re joining me as a former AutoCAD® user, you 

might compare BricsCAD Classic to AutoCAD LT®. Both applications focus on 2D design. 

However, while BricsCAD Classic offers all the tools you would expect for traditional 2D 

design, it also offers some you may not expect. 

 

Basic 3D Design Visualization 

The design industry often separates 2D and 3D design. But the distinction can be a little 

fuzzy. You may produce 2D design documents but the things you design are almost certainly 

3 dimensional. And, there’s a good chance your design integrates something designed by 

others. For example, maybe you produce 2D drawings of a building that require you to 

represent various components of the elevator. If a 3D model of that elevator exists, why not 

take advantage of it? 

While BricsCAD Classic doesn’t let you create 3D models, it does allow you to view and 

analyze them with basic tools. You can, for example, orbit a 3D model using the Lookfrom 
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tool as well as other common navigation methods. And, you can use the Section Plane tool 

to cut a temporary section plane through a solid model. 

 

The Classic edition also supports visual styles so you can view the model with hidden lines 

removed or more realistically. Some visual styles are even handy for your 2D designs. For 

example, you can give them a sketched appearance using the Sketchy visual style. 
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In addition to the obvious benefit of visualizing relevant 3D designs, you can take accurate 

measurements. Plus, you can use draw and snap tools to accurately recreate relevant 

geometry for your 2D drawings. 

3D Mesh Modeling 

Some of the basic mesh modeling tools that you may be familiar with from AutoCAD® are 

available in the BricsCAD Classic edition. For example, you can create mesh primitives (box, 

cylinder, torus, etc) and other mesh objects. While these mesh modeling tools don’t offer the 

advanced 3D modeling functionality offered in the Pro and Platinum editions, they do offer 

an introduction to 3D modeling. 

BricsCAD LISP Advanced Development Environment (BLADE) 

All editions of BricsCAD, including Classic, offer full LISP support. You can run LISP routines 

developed in AutoCAD® and other CAD applications. And, you can develop your own in the 

BricsCAD LISP Advanced Development Environment (BLADE command). Learn more about 

BricsCAD LISP! 
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Learning and Support Resources 

Here are some great resources to help guide you! 

Learning BricsCAD –  Learn BricsCAD even with no prior CAD experience with this free online 

learning content. It includes instructional videos with corresponding exercises and drawings. 

BricsCAD for AutoCAD® Users eBook – Download an ebook that describes the advantages 

of moving to BricsCAD software, how it compares to AutoCAD®, and some of the transition 

issues to consider. 

BricsCAD Online Help – Access the BricsCAD Help system even if you don’t have access to 

the software. It offers detailed information from the User Guide, Command Reference, 

System Variables and the Developer Reference. 

 

 
 

106 

 

https://lessons.bricsys.com/
https://campaigns.bricsys.com/switching_autocad_to_bricscad
https://help.bricsys.com/hc/

